
iJSheet User Guide

Copyright Information

Copyright 2001, Investment Intelligence Systems Corporation. All Rights Reserved.

The information contained in this manual and accompanying software program is
copyrighted and all its rights are reserved by Investment Intelligence Systems
Corporation (IISC). IISC reserves the right to make periodic modifications of this
product without obligation to notify any person or entity of such revision. Copying,
duplicating, selling, or otherwise distributing any part of this product without the prior
consent of an authorized representative of IISC is prohibited.

JSheet and HyperSheet are registered trademarks of Investment Intelligence Systems
Corporation.

Disclaimer of Warranties

The software and users manuals are provided “as is” and without express or limited
warranty of any kind by either IISC or anyone who has been involved in the creation,
production, or distribution of the software, including, but not limited to the implied
warranties of the merchantability and fitness for a particular purpose. The entire risk as
to quality and performance of the software and users manuals is with you. Should the
software and users manuals prove defective, you (and IISC or anyone else who has been
involved in the creation, production, or distribution of the software) assume the entire
cost of all necessary servicing, repairs, or correction.

Some states do not allow the exclusion of implied warranties, so the above exclusion may
not apply to you.

Limitation of Liability

In no event will IISC or any other person involved in the creation, production, or
distribution of the software be liable to you on account of any claim for any damages,
including any lost profits, lost savings, or other special, incidental, consequential, or
exemplary damages, including but not limited to any damages assessed against or paid by
you to any third party, arising out of the use, inability to use, quality, or performance of
such software and users manuals, even if IISC or any other such person or entity has been
advised of the possibility for such damages, or for any claim by any party. In addition,
IISC or any other person involved in the creation, production, or distribution of the
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software shall not be libel for any claim by you or any other party for damages arising out
of the use, inability to use, quality, or performance of such software and users manuals,
based upon principals of contract warranty, negligence, strict liability for the negligence
of IISC or other tort, breach of any statutory duty, principals of indemnity or
contribution, the failure of any remedy to achieve its essentials purpose, or otherwise.

Some states do not allow the limitation or exclusion of liability for incidental or
consequential damages, so the above limitation may not apply to you.
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CHAPTER 1: INTRODUCTION

Welcome to JSheet! With a spreadsheet matrix, menus, palettes,
and an optional charting module, JSheet is a primary visual
interface to the JSServer engine. Existing files or templates can be
loaded, viewed, and manipulated. JSheet, achieves the look and
feel of a standard desktop spreadsheet, without the need for a
spreadsheet program to reside on your local hardware.

About this Manual
This manual provides basic instructions on how to use JSheet. In
most instances, easy-to-follow instructions are presented that step
you through the procedures discussed. For information on how to
use the functions that are available in JSheet, refer to the JSheet
Functions manual.

Chapter 1, Introduction contains information about the contents of
each chapter in this book, as well as the documentation
conventions used throughout the manual.
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Chapter 2, The JSheet Environment identifies the various
worksheet components and worksheet navigation methods. The
system preferences available JSheet are also discussed.

Chapter 3, JSheet File Actions provides information on how to
create, open, close, and save workbooks and worksheets. All of
the actions discussed in this chapter are performed using
commands in the JSheet File menu.

Chapter 4, Entering Data, explains how to enter data into cells and
ranges and how to edit data that you have entered.

Chapter 5, Creating Formulas, discusses formulas and formula
components. Information on how to identify the various
components of a formula; how to use numbers, strings, and
worksheet ranges as formula arguments; how to use the JSheet
operators; and how to determine the evaluation order of formulas is
addressed.

Chapter 6, Cut, Copy, and Move Data, explains how to use cut-
and-paste, copy-and-paste, and drag-and-drop techniques to
manipulate the data in your worksheets. Inserting and deleting
rows and columns of data are also discussed.

Documentation Conventions
Recognizing the following JSheet documentation conventions will
help you understand and use your documentation:

1. Book, chapter, and section titles are shown in italics (e.g., JSheet
Environment or Chapter 3: Entering Data).
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2. Entities that can be located on the screen are shown in boldface
type (e.g., the File menu, the Accept Entry button, or the OK
button).

3. File names are shown in proper case, boldface type (e.g.,
Chap4.jss).

4. Menu commands are shown in boldface type with the menu,
submenu, and command names separated by a slash (e.g.,
File/New or Edit/Copy Right). Menu names are listed first,
followed by submenu names and then command names.

5. Keys are denoted in all uppercase, condensed type (e.g., ENTER,
BACKSPACE, CTRL, or SHIFT).

6. Steps required to perform a task are numbered.

7. Function keywords appear in uppercase, condensed type
(DAYNAME or SUM). This convention is used to help you
recognize functions and their syntax. Functions are not case-
sensitive.

8. Function arguments are shown in lowercase type (expressions,
string1, or price).

9. Tip paragraphs offer additional details about the functionality
being described.

10. Important paragraphs contain vital instructions, cautions, or
other significant information about the feature or operation being
described.
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CHAPTER 2 : THE JSHEET
ENVIRONMENT

When JSheet is launched, a workbook window is displayed. The
workbook window includes a format bar, formula bar, worksheet
grid, worksheet tabs, and status bar. Right-click to display the
JSheet Menu.

This chapter introduces you to the JSheet environment. Read this
chapter to learn how to:

11. identify the components of the workbook window.

12. navigate within the worksheet grid.

13. use the components of the formula bar.

14. use the features available from the format bar.

15. access the commands available in the JSheet Menu.
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The Workbook Window
The workbook window contains the format bar, the formula bar,
the worksheet grid, the worksheet tabs, and the status bar. The
worksheet grid contains rows and columns that intersect to form
cells. All of the worksheet data is stored in the cells. The formula
bar, located above the worksheet grid, is used to enter and edit all
of the data stored in the cells. By default, each workbook has three
worksheets. The following illustration shows a workbook window.

The Worksheet Grid
Each row and column in the worksheet grid is labeled with a
heading. Rows are labeled with numbers; columns are labeled with
letters.

Figure 2-1

Format Bar

Formula Bar

Worksheet Grid

Status Bar

Worksheet Tabs
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Each cell in the worksheet is given an address based on the
headings of the column and row that intersect to form the cell. The
following illustration shows cell B5 (the intersection of column B
and row 5) as the current cell.

When a cell is selected, it is current. The current cell is outlined
with a border. If more than one contiguous cell is selected at a
time, the selected cells are referred to as a range. A range is
referenced using the addresses of the first and last cells in the range
(the “anchor” cells). The following illustration shows a worksheet
grid with a range selected. The address for the selected range is
B3..C5. The current cell in the range is B3. The first anchor cell of
the selected range is B3 and the last anchor cell is C5.

Figure 2-2

Current Cell

Figure 2-3
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Navigating Within the Worksheet Grid
You can use keystrokes or the scroll bars to move around in the
worksheet grid. Keystrokes provide shortcuts for moving around
the worksheet grid; scroll bars scroll the worksheet grid left, right,
up, or down. The following table lists keyboard shortcuts that you
can use to navigate within the worksheet grid.

Keystroke Scrolling Action
PAGE UP Scrolls the worksheet grid up one screen.

PAGE DOWN Scrolls the worksheet grid down one screen.

UP ARROW (↑) Moves the current cell up one row.

DOWN ARROW (↓) Moves the current cell down one row.

LEFT ARROW (←) Moves the current cell left one column.

RIGHT ARROW (→) Moves the current cell right one column.

CONTROL UP ARROW (↑) Moves to the first row.

CONTROL DOWN ARROW (↓) Moves to the last row.

CONTROL LEFT ARROW (←) Moves to the first column.

CONTROL RIGHT ARROW (→) Moves to the last column.

HOME Moves to the first column in the current row.

END Moves to the last column in the current row.

Current cell and
first anchor cell
of the range.

Last anchor cell
of the range.
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The Formula Bar
Every workbook window contains a formula bar. The following
illustration identifies the elements of the formula bar.

Using the Cell Entry Controls
You use the entry field, together with the Accept Entry, Cancel
Entry, and Begin Formula Entry buttons to enter and edit data in a
cell. To enter data in a cell, select a cell and begin typing. To enter
a formula in a cell, click the Begin Formula Entry button and then
type the formula. As you type, the characters are displayed in the
entry field and in the selected cell. To enter the information into
the selected cell, click the Accept Entry button or press ENTER. Or,
before you enter the information into the selected cell, you can
click the Cancel Entry button to discard the data you typed in the
entry field.

The Format Bar
The buttons on the format bar, shown in the following illustration,
can be used to control the appearance and display of the data you

Cancel
Entry
Button

Accept
Entry
Button

Entry FieldCurrent
Cell
Address

Begin
Formula
Entry
Button

Figure 2-4
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enter into your JSheet workbooks, as well as the appearance of
your worksheet grid.

The default values for many of the options available on the format
bar are set via the Format tab in the Preferences dialog box.

The JSheet Menu
Right-click while over the workbook window to access the JSheet
Menu. The menu contains nine menu items:

16. Use the Cut command to remove selected data from the
worksheet and place the data on the clipboard.

17. Use the Copy command to copy selected data to the clipboard.

18. Use the Paste command to insert the data contained on the
clipboard into the specified location on your worksheet.

19. Use the commands in the File menu to create and manage your
workbook files (e.g., New Book and Open Book). The

Font
Name

Font
Size

Boldface, Italicize,
Underscore Text

Left-align,
Center, Right-
align Text

Currency

Percentage

Decimal
Precision

Cell
Borders

Text
Color

Fill
Color

Figure 2-5
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commands you need to save, close, and print your worksheets
are also contained in the File menu.

20. Use the commands in the Edit menu to undo actions; copy and
clear data; perform specialized paste operations; and specify the
appearance of the numbers displayed in your worksheet grid.

21. Use the Sheet menu to recalculate your workbooks; to add
worksheets to or delete worksheets from your workbook; to
rearrange the order of the worksheets in your workbook; and to
rename your worksheets.

22. Use the View menu to display or hide the formula bar, the status
bar, the format bar, the grid headers and the cell grid; to send
messages to users who are sharing a workbook; to display the
charts generated for the current worksheet; and to freeze and
unfreeze panes.

23. Use the Preferences menu to specify text and numeric
formatting characteristics; workbook permissions and autosave
options; and client default settings for the formula bar, format
bar, and status bar.

24. Use the About menu to display the About JSheet dialog box,
which contains product information.

Setting JSheet Preferences
A comprehensive set of JSheet preferences enables you to
customize the display and performance of JSheet to meet your
needs. The preferences you select are used each time you launch
JSheet.

To set the JSheet preferences:
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1. Right-click to display the JSheet Menu and then choose Preferences
to display the Preferences dialog box.

2. There are three types of preferences you can set: Format,
Workbook and Client. Click the corresponding tab for the type of
preference you want to set.

3. Click the format setting(s) you want to change and enter the new
setting(s).

4. Click OK to apply all the preference settings.

Important: When you make changes to the preferences, you must
disconnect from and reconnect to JSheet to implement the changes.
Existing worksheets are not affected by the preference changes;
only new worksheets are affected.

Format Preferences
Format preferences allow you to customize the display of the text
and numbers you enter into your JSheet worksheets. The text
defaults also are used for the row and column headings, the text in
the formula bar, and the text displayed in the current cell address.
The settings available on the Format tab are:

25. Font Name. Select the font family that you want to use for the
data you enter into your JSheet worksheets. The default is Arial.
Click the dropdown arrow to display the list of font choices.

26. Font Size. Set the point size that you want to use for the data
you enter into your JSheet worksheets. The default is 12.

27. Font Color. Select the color that you want to use for the data
you enter into your JSheet worksheets. The default is black
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(RGB(0,0,0)). Click the color box to display the array of
available colors.

28. Font Alignment. Select the alignment you want to use for the
data you enter into your JSheet worksheets. The default is
General.

29. Font Bold. Check the Font Bold check box to display all of the
information you enter into your JSheet worksheets in boldface
type. The default is false (not boldface).

30. Font Italic. Check the Font Italic check box to display all of
the information you enter into your JSheet worksheets in italic
type. The default is false (not italic).

31. Font Underline. Check the Font Underline check box to
display underscores on all of the information you enter into your
JSheet worksheets. The default is false (not underscored).

32. Number Format. Select the format that you want to use for the
numbers you enter into your JSheet worksheets. The default is
Fixed. Click the dropdown arrow to display the list of number
format choices.

33. Precision. Use the Precision number wheel to specify the
number of decimal positions to display. A positive precision
defines the number of digits displayed to the right of the decimal
point. A negative precision defines the number of digits to the
left of the decimal point to which the number is rounded.

34. Hide Zero. Check the Hide Zero check box to hide the display
of any numbers in your worksheet cells that equal zero. The
default is false (zero values not hidden).

35. Show Commas. Check the Show Commas check box to
display a comma as the thousands separator for any number in
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your worksheet cells that is greater than 999. The default is false
(no comma displayed).

36. Show Parenthesis. Check the Show Parenthesis check box to
display negative numbers in your worksheet cells within a set of
open and close parentheses. The default is false (no parentheses
displayed).

37. Negative Color. Negative numbers in your worksheet cells can
be displayed in a color different than the color used to display
other data. Click the Negative Color color picker to select the
color you want to use to display negative numbers in your
worksheet cells.

38. Book Background Color. Click the Book Background Color
color picker to select the color you want to use as the
background color for your worksheet cell grid. The default is
white (RGB(255,255,255)).

Workbook Preferences
Workbook preferences govern the public read/write/save options
for all of your new workbooks. The settings available on the
Workbook tab are:

39. Public Read. Check the Public Read check box to enable
others to access any new JSheet workbooks you create. The
default is true (access enabled). Uncheck the check box to deny
access to others.

40. Public Write. Check the Public Write check box to enable
others to make changes to any new JSheet workbooks you
create. The default is true (changes enabled). Uncheck the
check box to prevent others from making changes to your
workbooks.
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41. Public Save. Check the Public Save check box to enable others
to save changes to any new JSheet workbooks you create. The
default is true (saving changes enabled). Uncheck the check
box to prevent others from saving changes made to your
workbooks.

42. Number of Sheets. Select the number of worksheets that are
available in a workbook. A workbook can contain a maximum
of 256 sheets; the default is 3.

Client Preferences
Client preferences control the display of the components of the
workbook window (the format bar, formula bar, and status bar).
Cell update tracking and duration are also established via the
Client tab.

43. Show Format Bar. Check the Show Format Bar check box to
display the JSheet format bar. The default is true (display format
bar). Uncheck the check box to hide the format bar.

44. Show Formula Bar. Check the Show Formula Bar check box
to display the JSheet formula bar. The default is true (display
formula bar). Uncheck the check box to hide the formula bar.

45. Show Status Bar. Check the Show Status Bar check box to
display the JSheet status bar. The default is true (display status
bar). Uncheck the check box to hide the status bar.

46. Cell Update Tracking. Select an option from the Cell Update
Tracking dropdown to activate the tracking of numeric changes
made to your worksheets. When this option is activated, you
must specify the Cell Tracking Up Color, the Cell Tracking
Down Color, and the Cell Tracking Duration preference
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options. The default for this option is None (no cell update
tracking).

47. Cell Tracking Up Color. To see any changes that are made to
the values in the cells of your worksheets, activate the Cell
Update Tracking preference option. Right-click the Cell
Tracking Up Color color box to display the color picker. Select
the color to use when the change results in an increase in the
cell’s value.

48. Cell Tracking Down Color. To see any changes that are made
to the values in the cells of your worksheets, activate the Cell
Update Tracking preference option. Right-click the Cell
Tracking Down Color color box to display the color picker.
Select the color to use when the change results in a decrease in
the cell’s value.

49. Cell Tracking Duration (seconds). Select the frequency, in
seconds, at which you want cell updates to be tracked. The
default is 2 seconds. This option is active only if a Cell Update
Tracking option is selected.

50. Broken Connection Timeout (seconds). Select the number of
seconds at which a broken connection is timed out. The default
is 20 seconds.

51. Rollover Year. Use this option to specify the 100-year period
for which 2-digit year input is allowed. The default is 1950.
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ACTIONS
JSheet file actions allow you to create, open, close, and save
workbooks that contain worksheets. You can also open documents
from other applications and save workbooks in foreign formats.
All of the file actions discussed in this chapter are performed using
commands in the File menu.

Creating New Workbooks
You can create new workbooks at any time while working in
JSheet. To create a new workbook, choose File/New; the New
Workbook dialog box is displayed. In the dialog box, you can
specify the book name, a template to use, public access, and
whether the new book can be shared. Press OK and a blank
workbook that contains three worksheets is displayed on the
screen. This workbook becomes the current window. By default,
the new workbook is given the name Book.jss.

Tip: You can select the Workbook tab in the Preferences dialog
box to change the default setting for the number of worksheets
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displayed in a workbook. The maximum number of worksheets
you can have in one workbook is 256.

Opening Existing Files
At any time while you are working in JSheet, you can choose to
open network files or additional workbooks that you have saved to
a file or that reside on the server. You do not have to close a
workbook to open another workbook. To open a workbook or
network file, select File/Open from the JSheet Menu. As shown in
the following illustration, the Open Workbook dialog box
contains three tabs: File, URL, and Shared.

Figure 3-1
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To open a workbook saved on your system:

1. In the Open Workbook dialog box, select the File tab.

2. Select and open the directory in which the file is stored.

3. Click the Files of type popup menu to select the type of file
to be displayed in the dialog box. By default, all JSheet files
are displayed; you can also open text files and Wingz, DIF,
SYLK, Excel, and Lotus 123 worksheets.

4. Select the file you want to open and click OK.

To open a network file:

5. In the Open Workbook dialog box, select the URL tab.

6. Specify the location of the network file by entering the full
URL.

7. Click OK.

To open a shared file:

8. In the Open Workbook dialog box, a list of files that are
currently open and available for sharing is displayed under
the Shared tab.

9. Select the file you want to share and click OK.

TIP: To open as shared a file that is not listed under the Shared
tab, click the File tab, select the file you want to open, check the
Open Shared check box, and click OK.
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Opening Files Created in Other Programs
As previously mentioned, JSheet can open files created in other
programs and saved in formats other than the JSheet workbook
format. The following table describes the file formats JSheet
recognizes, as well as the elements within the files that are
supported by JSheet.

File Type File Information
Wingz Files created with Wingz are opened with all numbers, text, formatting,

formulas, objects, and attached scripts intact.
DIF Files created in this format are opened with numbers and text intact.
SYLK Files created in this format are opened with numbers and text intact. All

formulas are retained except for those not supported by JSheet. Formulas that
are not supported by JSheet appear as text.

Excel Files created with Excel are opened with all numbers and text intact; number
and text formats are retained. All formulas are retained except those not
supported by JSheet. Formulas that are unsupported by JSheet appear as text.

123-1a Files created with Lotus 1-2-3, version 1a, are opened with all numbers and
text intact. Number and text formats are also retained. All formulas are
retained except for those not supported by JSheet Builder. Formulas that are
unsupported by JSheet Builder appear as text.

123-2.0 Files created with Lotus 1-2-3, version 2.0, are opened with all numbers, text,
and their formats intact. All formulas are retained except for those not
supported by JSheet Builder. Unsupported formulas are read as text.

Text Text files retain all numbers and text. Use the Text dialog box to enter the
delimiter you want to use.

Saving Workbooks
Right-click to select File/Save or File/Save As to specify where
the workbook is saved, the name it is given, and the file format
used. When you save a workbook, all worksheets, text, numbers,
formulas, formatting, page setup and report specifications, objects,
charts, passwords, and attached scripts are saved with the file.
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When you initially save a workbook, the Save Workbook dialog
box appears, and you are prompted to specify where and how the
file is to be saved.

Saving Workbooks in Foreign Formats
When you save a workbook, by default it is saved in JSheet format.
If you want to save your workbook so it can be used in other
programs, you can select a different file format. The following
table describes the formats available for saving your workbook.

Tip: Chart types and chart elements (such as, titles, footnotes, or
axis titles) added to a chart with the Workbook Builder interface
take advantage of new charting features. Because these features
were not available in Wingz 2.0, these chart elements are not saved
when you save a worksheet as a Wingz 2.0 worksheet.

Format Type Format Information
Wingz 2.0 Files saved in this format retain all Wing 2.0 supported worksheets,

numbers, text, formats, and formulas. Only the current worksheet is
saved.

Wingz 3.0 Files saved in this format retain all Wingz 3 supported workbooks,
worksheets, numbers, text, formats, and formulas.

DIF Files saved in this format retain only worksheet text and numbers. Only
the current worksheet is saved.

SYLK Files saved in this format retain all numbers and text, as well as
supported formatting and formulas. Only the current worksheet is saved.

Excel Files saved in this format retain all numbers, workbooks, text, and
supported functions. Supported formatting and formulas are also retained.
Charts and objects are not saved. All worksheets in the current workbook
are saved.

123-1a Files saved in this format retain worksheet numbers, text, and Lotus 123
supported formats. Formulas supported by this version of Lotus 123 are
also retained. Only the current worksheet is saved.

123-2.0 Files saved in this format retain worksheet numbers, text, and Lotus 123
supported formats. Formulas supported by this version of Lotus 123 are
also retained.
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HTML Files saved in this format retain all numbers, text, formats, and objects.
Text Files saved in this format retain only worksheet text and numbers.

Closing Workbooks
Closing a workbook removes the workbook from your screen. To
close a workbook, select File/Close.

If no changes have been made to a workbook since the last time it
was saved, the workbook closes. If changes have been made since
the last save, a dialog box appears that prompts you to save or
discard the changes before the workbook is closed.
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Once you have become familiar with the JSheet environment, you
are ready to enter data. There are several types of data that can be
entered in a workbook including numbers, text, and formulas.

Entering Data into a Cell
Because a selected cell is also the current cell, it is ready for data
input. The data can be text, numbers, or formulas. A maximum of
255 characters can be entered into a cell.

To enter data into a cell, type the data you want to place in the cell.
Press the ENTER key or click the Accept Entry button to enter the
data into the cell.

When you use the Accept Entry button to enter data into a cell,
the selected cell remains the current cell. When you use ENTER to
enter data into a cell, the current cell moves down one cell in the
column. Alternatively, you can press TAB to enter data into a cell
and move the current cell right one cell in the row.

If you make an error while entering data, use BACKSPACE to move
the insertion point backward and delete characters from the entry
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field. Or, position the pointer on the entry field data, click to
reposition the insertion point at the point where the error was
made, and then make the correction.

Entering Data into a Range
Because a range is a group of cells, entering data into a range is
similar to entering data into a cell. However, when entering data
into a selected range, you need to move the current cell to each cell
in the range so data can be entered throughout the range. Moving
the current cell through a range is referred to as stepping through
the range.

Stepping Through a Range
If you use TAB to accept data, you step through a range, by
columns, from left to right. SHIFT TAB steps you through a range, by
columns from right to left.

Positioning the Current Cell
When you enter data into a range, the current cell receives data
first. If the current cell is not where you want to begin to enter data
in the range, press TAB or SHIFT TAB to move the position of the
current cell to the point where you want to enter data.

Entering Range Data
To enter data into a range, type the data you want to place in the
first cell. Press TAB or SHIFT TAB to enter the data into the range and
move the current cell to the next cell in the range. When data is
entered into all of the cells in the range in consecutive order, the
current cell returns to the first cell into which you entered data.
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Defining Data Types
Text and numbers are the basic types of worksheet data. Data that
includes letters, punctuation marks, or symbols is considered text.
Data that includes only numeric characters is considered a number.
Data that includes numeric characters and letters, punctuation
marks, or symbols is considered text.

A third type of worksheet data is a formula. Formulas combine text
and numbers and perform some type of calculation or evaluation.
Formulas are always preceded by an equal sign (=). Refer to
Chapter 5, Creating Formulas for information on using formulas
in JSheet.

Entering Text
Text can be entered at any location on your worksheet. Most often,
text is used as a label for a column or row of numeric data.
Sometimes numbers are used as text. To enter a string of numeric
characters as text, precede the characters with a double quotation
mark (").

Entering Numbers
JSheet recognizes both positive and negative numbers. To enter a
positive number, enter only the string of numeric characters. (You
can precede the number with a plus sign (+), but it is not
necessary.) To enter a negative number, you must precede the
string of numeric characters with a minus sign (–).
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Important: When you enter a number, do not include currency
symbols or thousands separators; doing so causes the data to be
recognized as text. The only character other than numeric
characters that can accompany a number is the decimal separator.
The default decimal separator is the period (.) Currency symbols
and thousands separators are added to a number when it is
formatted. The number appears in the worksheet according to the
default number format specified in the Format tab of the
Preferences dialog box.

Entering Dates
Dates are a type of number. There are several methods for entering
a date. JSheet recognizes the abbreviations of months and years,
and the numeric representation of months. You can also use
hyphens (-), slashes (/), and periods (.) as separators. For example,
to enter the date September 11, 1999, you can enter 9/11/99, 9-11-
99, 9.11.99, September 11, 1999, or 11-September-99.

The date appears in your worksheet according to the default format
specified in the Format tab of the Preferences dialog box. To
change the format used to display dates in your current worksheet,
right-click to display the JSheet Menu. Then, select Edit/Number
Format from the menu and make the change in the Number
Format dialog box.

Entering Times
Time is also a type of number. You can enter time with hours,
minutes, and seconds. JSheet recognizes only the colon (:) as a
separator for time entries.
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Time can be entered with an AM or PM designation following the
time (e.g., 10:45AM or 10:45PM) or it can be entered using the 24-
hour format. For example, 10:45 PM also can be entered as 22:45.

Tip: Do not use periods when you enter AM and PM (e.g., a.m. or
A.M.). When you use periods with an AM or PM designation, the
time is read as a text string rather than as a number.

Editing Workbook Data
After you enter data into a workbook, you can replace the data in a
cell or edit parts of the data. Workbook data is edited using the
entry field. To edit data entered into a cell, double-click the cell
and change the data as needed.

To edit data in the formula bar:

10. Select the cell that contains the data you want to edit.

11. Position the pointer in the entry field at the point where you
want to begin to edit. The pointer appears as an I-beam
when positioned in the entry field.

12. Click to place an insertion point in the entry field. Or, click
and drag to highlight the section of the entry field you want
to edit. You can use BACKSPACE or DELETE to delete text
adjacent to the insertion point. Or, you can type to insert text
at the insertion point. If you select a section of data, the
entire section of data is deleted if you press BACKSPACE or
DELETE, or begin typing

13. Enter your changes in the entry field.
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14. Click the Accept Entry button or the ENTER key to enter the
edited data in the worksheet. If you do not want to enter the
edited data in the worksheet, click the Cancel Entry button.

Linking Worksheets
A cell in your worksheet can reference a cell in any worksheet in
that workbook. A reference to a cell in another worksheet is called
an external reference. Worksheets that contain external references
are called linked worksheets.

A cell with an external reference displays the data from the
external worksheet it references. When a cell with an external
reference is the current cell, the entry field displays the name of the
worksheet and cell to which it is linked.

To link worksheets:

15. Open the workbook that contains the worksheets you want to
link.

16. Select the cell in which you want to place the external
reference.

17. Enter an equal sign (=), the name of the worksheet followed
by an exclamation point (!), followed by the cell to be
linked.

18. Press RETURN or click the Accept Entry button to enter the
external reference.
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The examples below are of formulas that contain links to other
worksheets.

Examples

=sheet3!B5
=sum(sheet5!A9, sheet6!A1)
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CHAPTER 5: CREATING
FORMULAS
In addition to providing the ability to create and store data and
graphical information, formulas allow you to put that data and
information to work quickly and efficiently.

This chapter teaches you how to use formulas, the keys that unlock
the power of your JSheet workbooks. Read this section to learn
how to:

52. identify the various components of a JSheet formula.

53. include functions in your formulas.

54. use numbers, strings, and worksheet ranges as arguments.

55. use the JSheet operators.

56. determine formula evaluation orders.
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Introducing Formulas
A formula is composed of one or more functions, numbers, strings,
ranges, operators, or any combination of these components. A
formula performs a calculation on data and provides the result of
that calculation. The data is evaluated and calculated in the order
of precedence defined by JSheet. The result of the calculation is
then placed in the worksheet cell where the formula is entered.
The following table describes the components of a formula.

Component Description
Function Built-in JSheet functions are used to calculate mathematical

operations and evaluate worksheet information.
Number This component provides the numeric data on which formulas

perform calculations.
String This component provides the textual data on which formulas

perform calculations.
Range This component references ranges of worksheet cells that contain

data used in formula calculations.

Entering Formulas
You can enter formulas directly into a worksheet cell or into the
Formula Bar. When entering a formula, the formula is preceded
by an equal sign (=), as shown in the following illustration. This
formula adds the values in cells A1 through A5 and places the total
in the cell containing the formula (A6).

Figure 5-1
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Combining Components in Formulas
Combining components in formulas allows you to produce more
complex calculations and evaluations. These formulas allow the
various operators, functions, and data to interact to provide specific
information for your worksheet.

When you combine components in a formula, it is important to
make certain the components interact to produce the type of data
needed to complete the formula calculation. For example, built-in
functions return specific types of data (such as, numbers, strings,
or ranges). The type of data returned must be appropriate to the
formula calculation. The following examples illustrate the uses of
functions in formulas.

Example

=ADDYEARS(30936, 19)

This example shows the most basic use of a function. The
ADDYEARS function is shown with numbers used for its two
arguments. The first number (30936) is a serial date number
representing the date September 11, 1984. The second number is
the number of years (19) to be added to that date.

Example

=ADDYEARS(DATEVALUE("September 11, 1984"), 19)

This example uses a function as an argument for another function.
DATEVALUE is used for the first argument of the ADDYEARS

function. DATEVALUE converts the string "September 11, 1984" to a
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serial date number. ADDYEARS then adds 19 years to this number, as
specified by the second argument.

Example

=(ADDYEARS(DATEVALUE("September 11, 1984"), 19)) >= 33832

This example performs the same calculation as the previous
example and evaluates the result against another number through
the use of a relational operator (>=). The result of the ADDYEARS

calculation is 37875. The formula evaluates this result to determine
if it is greater than or equal to (>=) the serial date number 33832.

Evaluation Order in Formulas
When you use more than one component in a formula, JSheet
evaluates and calculates the formula in an order of precedence.
This order is defined in the following table.

Order of Precedence Description
1 Parentheses Items surrounded by parentheses are given highest precedence. If

parentheses are nested within our parentheses, the inner level
receives the higher precedence.

2 Measurement operators Numbers with measurement operators (INCH(ES), MIL(S),
POINT(S), DECIPOINT(S), OR MILLIMETER(S)) are converted to
twips.

3 Exponentiation Exponential numbers are calculated.
4 Negative/Positive The negative or positive state of numbers is considered.
5 Multiplication/ Division Numeric operations involving multiplication (*) or division (/) are

calculated.
6 Addition/ Subtraction Numeric operations involving addition (+) or subtraction

(-) are calculated.
7 Relational Evaluation Evaluations involving relational operators (=, >, >=, <, <=, <>)

are performed.
8 Unary Logical Evaluations involving the logical operator NOT are performed.
9 String or Logical String concatenation (&) or logical evaluation involving the

logical operators AND and OR are performed.
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It is important to understand the order of evaluation when
combining components in formulas. The order of precedence can
easily change the order of formula evaluation, and ultimately, the
formula’s result.

Using Functions in a Formula
JSheet provides a set of built-in workbook functions. To access
these functions, right-click to display the JSheet Menu and then
select Edit/Paste Function to display the list of available
functions. The functions can be used alone or in combination with
other data in a formula.

Function Arguments

Each function has a unique name and set of data on which it
performs calculations. This data is referred to as an argument.
Arguments can be numbers, strings, or ranges.

Arguments are enclosed in parentheses. A function that requires no
arguments must be followed by a set of empty parentheses. When
multiple arguments are required, commas must separate the items
in the argument list. The following formulas contain functions that
require no arguments.

Examples

=NOW( ) +3
=RAND( )
=PI( )
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The following formulas contain functions that require arguments.

Examples

=INT(24.5970)
=ROUND(B7,2)
=MAX(C6, sheet5!B9, (sheet7!K12+sheet4!F6))

Functions can be entered in either uppercase or lowercase letters.
In this Guide, functions are shown in uppercase and arguments are
shown in lowercase.

Pasting Functions in a Formula

Instead of typing functions in your worksheet cells, you can paste
functions in cells using the Paste Function dialog box.

To paste a function:

19. Right-click to display the JSheet Menu and choose
Edit/Paste Function. The Paste Function dialog box
provides a list of the JSheet workbook functions, grouped by
type.

20. Select a function type from the Category list box to display
a list of functions in the Name list box.

21. Click a function name to select that function. Click the scroll
bar to the right of the list box to scroll through the functions.
When you select a function, the arguments required for the
function are displayed below the list boxes.
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22. Click Paste to paste the selected function into the current
cell in your worksheet.

23. After you paste the function from the Paste Function dialog
box, you must replace the arguments with valid data or cell
references to properly calculate the function.

Using Numbers in Formula Arguments
A number in a formula argument can be any numeric value (such
as,
5, 400,000, or -3482). The number is calculated according to the
operators and functions in the formula.

Dates and times are also considered numbers. JSheet uses a special
type of number, called a serial date number, to represent dates and
times. The serial date number is the number of days that have
passed since December 30, 1899, and can be any number from 0
(December 30, 1899) to 401768 (December 31, 2999). A negative
serial date number is evaluated as a date prior to December 30,
1899.

The fractional portion of a serial date number represents time. For
example, 0 represents midnight, .5 represents noon, .75 represents
6:00 p.m., and .875 represents 9:00 p.m. Therefore, the date
number 34764.65 represents 3:36 p.m. on March 6, 1995. This can
be demonstrated by placing 34764.65 into a cell, formatting the
cell (Edit/Number Format), and selecting the date format picture
of “3/4/98 1:30 PM.” When OK is clicked, 3/6/95 3:36 PM
appears in the cell.
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Using Strings in Formula Arguments
Strings in formula arguments are surrounded by a set of double
quotation marks (" "). Although strings are usually comprised of
alphabetic characters, they can also be numbers or combinations of
alphabetic and numeric characters.

When a number is surrounded by a set of double quotation marks,
JSheet recognizes it as a string and does not recognize its numeric
value. Zip codes, social security numbers, and telephone numbers
are examples of numbers often entered as strings. The following
formulas contain numbers entered as text.

Examples

="09812"
="816-541-3298"

Using Ranges in Formula Arguments
Ranges in formula arguments refer to worksheet cells that contain
data to be used in a formula. A range can contain multiple cells
(e.g., D3..F11) or a single cell (e.g., A1, B5, or C9).

For example, if the value in A1 is 6, the value in B1 is 8, and the
value in C1 is 2, the formula =(A1 + B1)/C1 returns the number 7.
The formula is calculated and the result is a numeric value.

Identifying Types of Range References

References to ranges can be relative (for example, C2 or A1..D4),
absolute ($C$2 or $A$1..$D$4), or combined (C$2 or $A1..$D4).
If a formula that contains a relative range is copied and pasted, the
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range is modified to preserve the cell relationships. If a formula
that contains an absolute range is cut or copied and pasted, the
range does not change. If a formula that contains a combined
reference is cut or copied and pasted, only the column or row that
is absolute does not change.

You can enter a range in a formula by typing the reference or by
selecting the range in the worksheet.

Using Ranges on Linked Worksheets

Ranges from other worksheets can be included in formulas. These
range references are called external references. You can reference
a range in any worksheet in the current workbook.

Using Operators in a Formula
The operator you use in a formula defines the type of calculation or
evaluation to be performed by the formula. Additionally, the
operator determines the amount of numbers, ranges, or strings
required by the formula. The five types of JSheet operators are
described in the following table.

Operator Definition
Numeric These operators perform arithmetic operations on numbers. The numeric

operators are: Addition (+), Subtraction (-), Multiplication (*), Division (/),
and Exponentiation (^).

Logical These operators evaluate a formula and return 1 if the evaluation is true
and 0 if the evaluation is false. The logical operators are:
AND - Requires values on both sides of the operator. Returns 1 only if
both values are true.
OR - Requires values on both sides of the operator. Returns 1 if either
value is true.
NOT - Requires only one value. Returns 1 when the comparison is false.
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Text This operator concatenates strings. The ampersand (&) is the concatenation
operator.

Measurement These operators convert numbers to twips (1/1440th of an inch or 1/20th of
a point), the standard JSheet measurement. The measurement operators are:
INCH(ES) Converts inches to twips.
MIL(S) Converts 1/1000th of an inch to twips.
POINT(S) Converts 1/72nd of an inch to twips.
DECIPOINT(S) Converts 1/10th of a point to twips.
MILLIMETER(S) Converts millimeters to twips.

Relational These operators evaluate two numbers, ranges, or strings to determine
whether they meet the criteria of the given operator. If the criteria are met,
1 (true) is returned. If the criteria are not met, 0 (false) is returned. The
relational operators are: Equal to (=), Greater than (>), Greater than or
equal to (>=), Less than (<), Less than or equal to (<=), and Not equal to
(<>).

The following examples demonstrate how the JSheet operators can
be used in your worksheet.

Numeric Examples Definition
45 + 183 Adds 45 and 183.
A4 – D7 Subtracts the contents of cell D7 from the contents of cell A4.
23 / A4 Divides 23 by the contents of cell A4.
C5 ^ 4 Calculates the contents of cell C5 to the fourth exponential power.

Logical Examples Definition
B2 > 4 AND C4 < 12 Returns 1 (true) if the contents of cell B2 is greater than 4 and the

contents of cell C4 is less than 12; returns 0 (false) if either portion
of the formula is not true.

C7 = B12 OR A2<10 Returns 1 (true) if the contents of cell C7 equals the contents of cell
B12 or the contents of cell A2 is less than 10; returns 0 (false) if
both portions of the formula are not true.

NOT B1>3 Returns 1 (true) if the contents of cell B1 is less than or equal to 3,
returns 0 (false) if the contents of cell B1 is greater than 3.

Text Examples Definition
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"Lenexa, "&"Kan" Concatenates the two strings in the example to produce the string
"Lenexa, Kan".

"Stock No. "&A2 Concatenates the string "Stock No. " and the contents of cell A2.

Measurement
Examples

Definition

1 INCH + 3 POINTS Converts 1 inch to 1440 twips and converts 3 points to 60 twips; the
results are added together.

10 MILS + B2 Converts 10 milliinches to 14.40 twips. The result is added to the
value in cell B2.

Relational Examples Definition
34 + 24 > B2 Returns 1 (true) if the sum of 34 and 24 is greater than the value

in cell B2; returns 0 (false) if the sum of 34 and 24 is less than or
equal to the value in cell B2.

E5 < > A2 + C4 Returns 1 (true) if the value of cell E5 is not equal to the sum of
the values in cells A1 and C4; returns 0 (false) if the value of cell
E5 is equal to the sum of the values in cells A2 and C4.

Understanding Error Messages
Formulas that cannot be calculated or evaluated return errors.
Errors can be caused by using the incorrect syntax for a function,
providing incorrect data for a formula, or using an incorrect
operator.

When a formula returns an error, the error (ERR number) appears
in the cell where the formula was entered. Number refers to a
particular error message in the JSheet error message list.
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CHAPTER 6: CUT, COPY, AND
MOVE DATA
JSheet provides multiple methods for moving and copying data in
your workbooks. You can perform simple cut, copy, and paste
tasks; you can drag-and-drop blocks of data; or you can perform
more complex tasks that clear and paste individual elements of
your data. You can also insert or delete rows and columns of data,
or move data between worksheets.

Cutting Data
To cut data, select the range containing the data that you want to
cut, right-click to display the JSheet Menu, and choose Cut from
menu. Data from the selected range is removed from the worksheet
and placed on the clipboard. The range that contained the cut data
is now empty. The formatting associated with the data is also
removed.

Tip: You can also use the shortcut key combination CTRL X to
execute the File/Cut command.
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Copying Data
To copy data, select the range containing the data that you want to
copy, right-click to display the JSheet Menu, and choose Copy
from the menu. A copy of the data from the selected range is
placed on the clipboard. The selected data remains in the
worksheet, along with the formatting associated with the data.

Tip: You can also use the shortcut key combination CTRL C to
execute the File/Copy command.

Copying Data Across Ranges
Copying data across a range allows you to duplicate data from the
top row or left column of a selected range and copy it across the
range.

To copy data across a range:

24. Select the range across which you want to copy data.

25. Right-click to display the JSheet Menu and choose
Edit/Copy Right to copy the data in the left column across
the selected range.

26. Right-click to display the JSheet Menu and choose
Edit/Copy Down to copy the data in the top row down the
selected range.

Tip: You can also use the shortcut key combination CTRL R to
execute the Edit/Copy Right command and CTRL D to execute the
Edit/Copy Down command.
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If the data you copy contains formulas with relative references, the
references are updated as the formulas are copied. If the range
across which data in the top row or left column is copied contains
other data, the other data is overwritten by the copied data.

The following illustrations demonstrate the effect of copying data
across a selected range. The first worksheet shows a selected range
before Edit/Copy Right is executed. The second worksheet shows
the result of the action.

The next two illustrations show the effect of using the Edit/Copy
Down option. The first worksheet shows a selected range before
the copy option is used. The second worksheet shows how the data
in the top row of the selected range is copied down the range.

Figure 6-1

Figure 6-2

Figure 6-3
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Pasting Data
To paste data, select the range in which you want to place the data
that is on the clipboard. You can select a single cell or a range of
cells for pasting the data. Then, right-click to display the JSheet
Menu and choose Paste from the menu.

Tip: You can also use the shortcut key combination CTRL V to
execute the File/Paste command.

The data you cut or copied to the clipboard is placed in the
worksheet range you selected. You can repeat this procedure as
many times as you need to paste multiple copies of the data from
the clipboard. The data remains on the clipboard until you cut or
copy another range of data or an object.

Figure 6-4
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How data from the clipboard is pasted into the worksheet depends
on the size of the range into which you are pasting the data. The
following illustrations demonstrate data pasted into a single cell, a
range larger than the clipboard data range, and a range smaller than
the clipboard data range.

In the first illustration, the range A1..C4 was selected and copied to
the clipboard. In the second illustration, cell A8 was selected when
the Paste command was chosen from the JSheet Menu. When a
single cell is selected, the data is pasted into as many cells as
needed, with the selected cell serving as the top left cell of the
range. Any data in these cells is overwritten by the pasted data.

In the next illustration, the range A8..C9 was selected when the
Paste command was chosen from the JSheet Menu. When the

Figure 6-5

Figure 6-6

Figure 6-7
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selected range is smaller than the data range, the pasted data is
truncated to fit the selected range.

In the following illustration, the range A8..C13 was selected when
the Paste command was chosen from the JSheet Menu. When the
selected range is larger than the clipboard data range, the pasted
data is repeated until the selected range is filled.

Pasting Data Between Worksheets
Data that has been cut or copied from one worksheet can be pasted
into another worksheet in the open workbook. After cutting or
copying the data from the worksheet, click the name tab for the
worksheet into which you want to paste the data. Select the cell or

Figure 6-8
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range into which you want to paste the data, right-click to display
the JSheet Menu, and choose Paste from the menu.

Pasting Selected Data Elements
When data is pasted from the clipboard into a cell in your
worksheet, the clipboard data, plus any associated formatting, is
pasted. To paste only the data or only the formatting from the
clipboard to the selected cell(s), you can use the Paste Special
commands.

If the clipboard data contains numbers, you can also use
Edit/Paste Special commands to add, subtract, multiply, or divide
the clipboard data values with numbers in your worksheet.

To use Paste Special:

27. Select the range that contains the data on which you want to
perform a special paste.

5. Right-click to display the JSheet Menu and choose Edit/Paste
Special to display the Paste Special dialog box.

6. Select the desired Paste or Operation action and click OK.

Moving Data
You can use a drag-and-drop technique, a combination of cut-and-
paste commands, or a combination of copy-and-paste commands to
move worksheet data.
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57. Use the cut-and-paste combination or the drag-and-drop
technique if you want to remove data from its original location
and place it in another location in the worksheet grid.

58. Use the copy-and-paste combination if you want to leave data in
its original location and place a copy of the data in another
location in the worksheet grid.

To use the drag-and-drop technique:

28. Select the range that contains the data that you want to
move.

7. Drag the cursor to the bottom right corner of the selected range.
(Notice a small box appears at the bottom right corner of the selected
range.)

8. Drag the block of data to the location in your worksheet where you
want to move the data. (Notice that a green block appears to indicate
where the block of data is being moved.)

9. When the block is in the correct location, drop the data into the
indicated location by releasing the mouse button. The range of data is
displayed in the new location.

Deleting Data
If you want to remove data from your worksheet and do not want
to paste the data in another location, you can use the Clear
command. Unlike Cut, which removes data from your worksheet
and places it on the clipboard, the Clear command removes the
data and does not place it on the clipboard.
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To remove data from a worksheet, select the data to be removed,
right-click to display the JSheet Menu, and choose Clear from the
menu; the Clear dialog box is displayed. You can choose to
remove all of the data, formatting, and formulas contained in the
selection, or you can choose to remove only the data, only the
formats, or only the formulas.
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functions in, 5-2, 5-4
numbers as text in, 5-7
numbers in, 5-2, 5-6
operators in, 5-8
order of precedence in, 5-4
pasting functions in, 5-6
ranges in, 5-2, 5-8
text strings in, 5-2, 5-7
times in, 5-7

Functions
arguments in, 5-5
built-in, 5-4
formulas and, 5-2
pasting, 5-6

H

HTML, saving worksheets as,
3-5

J

JSheet environment
preferences, 2-7
workbook window, 2-1

L

Labeling rows and columns, 2-2
Linking worksheets, 4-5
Logical operators, 5-9
Lotus 1-2-3 files

opening worksheets from, 3-4
saving worksheets as, 3-5



M

Measurement operators, 5-9
Moving data, 6-7

N

Navigating the worksheet grid,
2-3

Network files, opening, 3-3
New workbooks, 3-1
Numbers

as text in formulas, 5-7
currency symbols, 4-3
entering, 4-3
in formulas, 5-2, 5-6
thousands separators, 4-3

Numeric operators, 5-9

O

Opening
network files, 3-3
workbook files, 3-2

Opening foreign files, 3-4
Operators

in formulas, 5-8
types of, 5-9

P

Paste Function dialog box, 5-6
Pasting

data, 6-4
data between worksheets, 6-6
functions, 5-6
selected data elements, 6-6

Precedence, order of, 5-4

Preferences
client, 2-11
format, 2-8
setting, 2-7
workbook, 2-10

R

Ranges
addresses of, 2-3
anchor cells in, 2-3
copying data across, 6-2
definition of, 2-3
entering data into, 4-2
in formulas, 5-2, 5-8
positioning current cell in, 4-

2
stepping through, 4-2
types of references, 5-8

Relational operators, 5-9
Relative range references, 5-8
Rows

copying data down, 6-2
labeling, 2-2

S

Saving
workbooks, 3-4
workbooks in foreign

formats, 3-5
Sheet menu, contents of, 2-6
SYLK files

opening worksheets from, 3-4
saving worksheets as, 3-5



T

Text
as numbers in formulas, 5-7
entering, 4-3
in formulas, 5-2, 5-7

Text files
opening worksheets from, 3-4
saving worksheets as, 3-5

Text operator, 5-9
Times

entering, 4-4
formulas and, 5-7

W

Wingz 2.0
saving worksheets as, 3-5

Wingz 3.0
saving worksheets as, 3-5

Workbook preferences, 2-10
Workbook window, 2-1

formula bar, 2-4, 2-5
worksheet grid, 2-2

Workbooks
closing, 3-6
creating, 3-1
exporting, 3-5
linking, 4-5
opening, 3-2
saving, 3-4

Worksheet grid, 2-2
navigating within, 2-3

Worksheets
opening foreign, 3-4


